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Комплект инструментов Resource Kit предназначен для применения в

организациях, эксплуатирующих систему Docsvision.

Resource Kit содержит набор системных утилит различного назначения,

предназначенных для специалистов Docsvision.

Resource Kit включает следующие программы:

1. CardManager — программа для создания и регистрации схем метаданных

библиотек карточек.

"CardManager" предоставляет следующие функции:

◦ Создание схем метаданных библиотек карточек.

◦ Создание схем метаданных карточек.

◦ Загрузка разработанных схем метаданных в БД Docsvision.

2. DVExplorer — программа для работы с данными Docsvision на низком уровне.

"DVExplorer" предоставляет следующие функции:

◦ Просмотр/изменение данных карточек Docsvision.

◦ Формирование и выполнение поисковых запросов.

◦ Получение детальной информации о типах карточек, загруженных в БД

Docsvision.

◦ Управление блокировками и др.
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Необходимые ресурсы

Требования серверной части модуля

Для установки на Linux:

• Astra Linux Special Edition 1.7.

• Astra Linux Special Edition 1.8.1.

• РЕД ОС 8.

Необходимое техническое обеспечение

Специальные требования к аппаратному обеспечению не предъявляются.

Требования к системе Docsvision

Требуется установить перечисленные ниже модули, настраивать не нужно.

1. Клиентская часть модуля Платформа версии 6.1.

2. Клиентская часть модуля Windows-клиент версии 6.1.
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Изменения, обновления и
исправленные ошибки

Пакет утилит Resource Kit

Общая документация

Общая информация об изменениях, исправленных ошибках и

накопительных обновлениях.

• Изменения в релизной версии

• Исправленные ошибки

• Накопительные обновления

Изменения в релизной версии

• Новая версия утилит переведена на .NET 6.0 с возможностью подключения к

серверу на ОС Astra Linux.

Исправленные ошибки

DV5-5290 (SUP-3169) При использовании БД PostgreSQL открытие

карточки в программе DVExplorer приводило к

ошибке "Unable to find cards. Error: (0x80040501)

Произошла SQL ошибка при выполнении операции с

данными на сервере".

DV5-5296 (SUP-3169) При использовании БД PostgreSQL атрибутивный

поиск в программе DVExplorer завершался ошибкой

"Unable to find cards. Error: (0x80040501)

Произошла SQL ошибка при выполнении операции с

данными на сервере".

DV5-5693 При поиске файлов в программе DVExplorer не

учитывались ограничение по дате создания.

DV5-5763 При изменении SID пользователя в программе

ChangeAccount возникало необработанное

исключение, если был указан несуществующий SID.
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Накопительные обновления
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Руководство администратора модуля

Установка комплекта инструментов

Пользователь, выполняющий установку, должен обладать правами локального

администратора.

1. Запустите пакет установки ResourceKit.msi.

Рисунок 1. Мастер установки {Resource Kit

2. Примите условия лицензионного соглашения для продолжения установки.
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Рисунок 2. Условия лицензионного соглашения

3. Если требуется, измените каталог установки.

Рисунок 3. Каталог установки Resource Kit

4. Нажмите на кнопку Установить и дождитесь завершения установки Модуля.
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5. Нажмите на кнопку Готово, чтобы закрыть мастер установки.
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Руководство пользователя

Запуск программы

Для запуска программы, входящей в Resource Kit, используйте соответствующий

ярлык в меню Пуск › Docsvision › ResourceKit.
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CardManager

Программа CardManager предназначена для разработки схем метаданных

библиотек карточек и карточек, а также загрузки схем в БД Docsvision.

Рисунок 4. Главное окно программы "CardManager"

Главное окно программы содержит следующие элементы:

• Панель инструментов.

• Дерево объектов с элементами:

◦ Card libraries — библиотеки карточек, загруженные в программу.

◦ Databases — базы данных Docsvision, подключенные к программе, со

списком загруженных библиотек карточек.

• Список карточек выбранной библиотеки карточек.


Примеры использования программы CardManager приведены в

/dv6/programmer/dv6/[Руководстве по разработке].

Общие понятия

Ключевой сущностью системы Docsvision является карточка, представляющая

собой пакет данных, который обладает определенной структурой, описываемой

схемой метаданных карточки.
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Помимо описания структуры данных, схема метаданных также содержит общую

информацию о типе карточек (название типа, возможность создания карточек

этого типа, возможность их копирования и др.).

Каждая карточка принадлежит к определенному типу со своей уникальной

схемой метаданных.

Типы карточек являются частью большей структуры, называемой библиотекой

карточек. Библиотека карточек содержит список типов карточек, включенных в

неё, ссылку на пакет установки программных компонентов карточек (если

предусмотрено использование компонентов) и некоторую другую информацию.

Программист, в зависимости от требований, может создать новую библиотеку

карточек и включить в неё типы карточек, либо использовать для этого

существующую библиотеку.

Создание новой библиотеки карточек

1. Выберите узел Card libraries в дереве объектов.

2. Вызовите команду File › New › New Library. Будет открыто окно сохранения

файла.

3. Укажите путь для сохранения файла со схемой библиотеки карточек.

В список библиотек карточек будет добавлена новая библиотека.

4. Выберите добавленную библиотеку в узле Card libraries дерева объектов.

5. Настройте основные параметры библиотеки карточек.

6. Добавьте отчеты, загружаемые в БД с библиотекой карточек.

7. Объявите список журналируемых операций карточек библиотеки.

8. Добавьте пакеты установки клиентских компонентов карточек.

9. Нажмите кнопку OK для сохранения настроек.

Настройка основных параметров

1. Откройте настройки библиотеки карточек (Edit › Library Properties).

2. Перейдите на страницу основных настроек Library.
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Рисунок 5. Страница настройки основных параметров библиотеки карточек

3. Укажите основные параметры библиотеки карточек:

◦ Alias — псевдоним библиотеки карточек. Не должен содержать

спецсимволов, пробелов и символов не латинского алфавита.

◦ Название — локализованные названия библиотеки карточек.

◦ ID — уникальный идентификатор данной библиотеки карточек. Создаётся

автоматически.

◦ Version — версия библиотеки карточек — в т.ч. используется при проверке

актуальности клиентского компонента.
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◦ Activation string — строка активизации компонента библиотеки карточек,

содержащая идентификатор COM-компонента библиотеки. COM-компонент

необходим для загрузки клинского компонента библиотеки Windows-

клиентом, укажите его при разработке клиентского компонента.

◦ ProgID — программный идентификатор COM-компонента библиотеки.

◦ MSI Product Code — код установочного компонента библиотеки для

автоматической установки.

◦ MSI Package Name — путь к установочному компоненту библиотеки.

◦ Icon file — путь к иконке библиотеки карточек — используется при

отображении библиотеки в Windows-клиенте.

Добавление отчетов

Отчёты — хранимые процедуры БД, которые могут использоваться для прямого

обращения к БД, минуя объектную модель и средства безопасности Docsvision.

Использования отчётов позволяет (в некоторых случаях) ускорить доступ к

данным, получить сложную выборку данных, получить данные из сторонней

базы данных или сервера и т.п.


Методы, предоставляемые отчетами, выполняются вне моделей

безопасности Docsvision, поэтому программист должен

самостоятельно обеспечить необходимые ограничения.

Хранимая процедура отчет имеет определенный набор входных и выходных

параметров, а также уникальный идентификатор, по которому данный отчет

может быть вызван.

Ниже приведён код примера отчёта для Microsoft SQL и PostgreSQL,

возвращающего список замещаемых сотрудников, для которых @EmployeeID
указан заместителем в Справочнике сотрудников.

Версия для СУБД Microsoft SQL

BEGIN
 SELECT [RowID], [ParentRowID], [IsNotified]
 FROM  [dbo].[dvtable_{ED414CB4-B205-4BE4-A2FA-5C0D3347CEB3}] WITH(NOLOCK)
 WHERE [DeputyID] = @EmployeeID
END
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Версия для СУБД PostgreSQL

$$
BEGIN
    RETURN query
    SELECT tDeputies."RowID", tDeputies."ParentRowID", tDeputies."IsNotified"::integer
    FROM  public."dvtable_{ed414cb4-b205-4be4-a2fa-5c0d3347ceb3}" tDeputies
    WHERE tDeputies."DeputyID" = val_EmployeeID;
END;
$$
LANGUAGE plpgsql volatile;

Чтобы добавить новый отчет в библиотеку карточек:

1. Создайте файл отчета с хранимой процедурой (пример приведен выше) для

Microsoft SQL и/или PostgreSQL (в зависимости от целевой СУБД).

Файл(ы) нужно разместить в одном каталоге (или в подкаталоге) с файлом

схемы библиотеки карточек.

2. Откройте настройки библиотеки карточек (Edit › Library Properties).

3. Перейдите на страницу настройки отчетов Reports.
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Рисунок 6. Страница настройки отчетов

Чтобы настроить основные параметры отчета:

4. Нажмите кнопку Add в разделе Procedures. В список Procedures будет

добавлена новая запись.

5. В поле Alias введите псевдоним отчета, по которому данный отчет может быть

вызван с помощью API Docsvision.

6. В таблице Названия введите локализованные названия отчета.
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Рисунок 7. Пример настройки основных параметров отчета

Укажите SQL-файлы c разработанными хранимыми процедурами:

7. На странице Reports откройте вкладку SQL files .

8. Нажмите на кнопку Add на вкладке SQL files. В список Files будет добавлена

новая запись.

9. В поле SQL file выберите SQL-файл, содержащий хранимую процедуру. После

добавления путь необходимо изменить на относительный (относительно

файла схемы библиотеки карточек).

10. В поле Server type выберите тип СУБД, для которой предназначен файл:

Microsoft SQL или PostgreSQL.
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
Типы СУБД Oracle и MySQL, представленные в списке, не

поддерживаются системой Docsvision.

11. Если требуется ограничить применение SQL-файла версией СУБД, укажите её

в поле Server version.

Если версия не указана, хранимая процедура может быть загружена в БД,

работающую под управлением СУБД любой версии.

Рисунок 8. Пример настройки файлов отчета

12. Если требуется, добавьте аналогичным образом другие файлы отчетов.
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13. Если хранимая процедура принимает входящие параметры, настройте их на

вкладке "Parameters":

a. На странице Reports откройте вкладку Parameters.

b. Нажмите на кнопку Add. В список Parameters будет добавлена новая

запись.

c. В поле Parameter name введите название параметра, принимаемого

хранимой процедурой.

d. Выберите тип параметра в списке Parameter type.

Рисунок 9. Пример настройки параметров отчета
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e. Если требуется, аналогичным образом добавьте другие параметры

хранимой процедуры.

14. Если хранимая процедура возвращает значения, настройте их на вкладке

Report result.

a. На странице Reports откройте вкладку Report result.

b. Выберите формат возвращаемого значения:

▪ Scalar result — если хранимая процедура возвращает единичное

значение.

▪ TableResult — если хранимая процедура возвращает набор значений.

c. Для варианта Scalar result:

i. Выберите тип возвращаемого значения в списке Data type.

ii. Настройте значения: Precision и Scale (только для полей с плавающей

точкой), Size (максимальный размер), Nullable (может быть пустым).

iii. Нажмите кнопку Add. В таблицу Columns будет добавлена новая запись.

d. Для варианта TableResult:

i. Нажмите на кнопку Add на вкладке Report result. В таблицу Columns

будет добавлена новая запись.

ii. Введите название колонки с возвращаемым значением в поле Name.

iii. Выберите тип возвращаемого значения в списке Data type.

iv. Настройте параметры: Precision и Scale, Size, Nullable.

v. Если требуется, аналогичным образом настройте параметры других

возвращаемых колонок.
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Рисунок 10. Пример настройки параметров возвращаемого значения

Объявление типов журналируемых операций

Для протоколирования работы пользователя с карточкой может использоваться

журнал работы Docsvision. Чтобы задействовать данную возможность, нужно

объявить протоколируемые операции в схеме библиотеки карточек и вызывать в

компоненте карточки функцию записи соответствующего события в журнал.

Чтобы объявить журналируемую операцию:

1. Откройте настройки библиотеки карточек (Edit › Library Properties).

2. Перейдите на страницу настройки журналов Log.
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Рисунок 11. CardManager — Журналируемые операции

3. Вызовите команду New Operation из контекстного меню узла Operations.

4. Введите псевдоним и локализованные названия операции.

Регистрация пакетов установки

Библиотека карточек может требовать от Windows-клиента установки своих

программных компонентов, необходимых на стороне клиента.

Для работы данного механизма пакеты установки клиентских компонентов

библиотеки карточек должны быть зарегистрированы в схеме библиотеки

карточек.
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1. Откройте настройки библиотеки карточек (Edit › Library Properties).

2. Перейдите на страницу настройки пакетов установки Installers.

Рисунок 12. CardManager — Пакеты установки

3. Введите идентификатор пакета установки в поле Package ID.

4. Введите относительный путь к пакету установки в поле Installer.

5. Введите код продукта (пакета установки) в поле Product code.

6. Нажмите кнопку Add.

Запись будет добавлена в список пакетов установки.
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7. Если требуется, добавьте другие пакеты установки.


Инструкция по разработке пакета установки клиентских

компонентов библиотеки карточек приведена в

/dv6/programmer/dv6/[Руководстве разработчика].

Добавление новой карточки

1. Выберите в дереве объектов библиотеку карточек, в которую добавляется

новая карточка.

2. Вызовите команду New Card из контекстного меню узла библиотеки карточек.

3. В появившемся окне укажите файл для сохранения схемы метаданных.

В список карточек библиотеки будет добавлена новая запись.

Рисунок 13. CardManager — Добавление карточки в библиотеку карточек

4. Настройте основные параметры карточки.
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5. Добавьте секции и поля карточки.


Для корректной работы карточки требуется наличие у неё, как

минимум, одной секции.

6. Зарегистрируйте команды карточки.

7. Зарегистрируйте режимы работы карточки.

8. Зарегистрируйте преобразования карточки.

9. Добавьте виртуальные поля.

Настройка основных параметров карточки

1. Выберите карточку в списке карточек.

2. Откройте настройки карточки (Edit › Card Properties).

Рисунок 14. CardManager — Описание карточки
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3. Выберите корневой узел в схеме карточки (название совпадает с названием

карточки).

4. Введите псевдоним карточки в поле Псевдоним.

5. Введите локализованные названия карточки в таблице Названия.

6. Введите идентификатор COM-компонента карточки в поле Строка

активизации.

Строка активизации может содержать программный идентификатор (ProgID),

идентификатор класса (CLSID) и данные о лицензировании. Не требуется для

.NET-карточек (карточки, реализованные с помощью технологии .NET).

7. Введите полное название класса, реализующего интерфейс (и связанную

логику) карточки, в поле Имя типа.

Для .NET-карточек следует указывать Имя типа вместо ProgID и строки

активации.

8. Введите путь к иконке карточки в поле Путь к файлу с иконкой, или

выберите иконку нажав на кнопку .

 Рекомендуется указывать относительные пути.

9. Выберите режим чтения данных карточки в списке Режим чтения данных:

◦ FETCH_CARD (карточка целиком) — при обращении к карточке все её

данные будут переданы клиенту.

◦ FETCH_SECTION (секция) — при обращении к данным карточки будет

прочитана целиком соответствующая секция.

◦ FETCH_SUBSECTION (подсекция) — чтение только данных подсекций.

◦ FETCH_LEVEL (уровень) — чтение только данных одного уровня дерева

(при работе с иерархическими секциями).

◦ FETCH_ROW — чтение только данных одной строки.

10. Настройте дополнительные атрибуты карточки:

◦ Do not mark card as unread — включает и выключает режим, при котором

новая карточка не будет помечаться как непрочитанная.

◦ Card can be marked as template by user — разрешает пользователям

конвертировать карточку в шаблон.
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◦ Instances can be copied — разрешает или запрещает копирование карточки.

◦ Card needs custom XML export procedure — указывает, что карточка использует

нестандартную процедуру выгрузки в XML (стандартные пункты меню

будут недоступны).

◦ Dictionary (only one instance allowed) — включает и выключает режим, при

котором в БД может существовать единственный экземпляр карточки

данного типа (используется для справочников).

◦ Can work as folder card — указывает, что карточка реализует

функциональность папки (такую функциональность реализует системная

карточка папок, которую разработчик может подменить собственной).

◦ Items can be selected from this card — указывает, что карточку можно

использовать для выбора её элементов (запускать в режиме выбора).

◦ Do not create hard shortcuts — запрещает создавать сильный ярлык на

карточку.

◦ Do not lock the card when opened — отключает блокировку карточки при

открытии (разработчик должен самостоятельно организовать механизм

блокирования карточки).

◦ Non-archival — запрещает архивировать карточку.

◦ System (user cannot create instance) — запрещает пользователям создавать

карточки данного типа. Используется для карточек без пользовательского

интерфейса. Экземпляры таких карточек могут быть созданы только

программно.

◦ User cannot delete card instances — запрещает пользователям удалять

карточки данного типа.

◦ Card cannot be replicated — запрещает реплицировать экземпляры карточек

данного типа.

◦ Non-searchable — указывает, что карточка не участвует в поиске и не

индексируется.

◦ Hidden — скрывает экземпляры карточек данного типа от пользователей.

◦ Replicate only card templates — указывает, что в процессе репликации будут

участвовать только те карточки данного типа, которые помечены в

качестве шаблонов.

◦ Allow to open as linked card — разрешает или запрещает открытие карточек

данного типа из других карточек.

25



◦ Card is securable — включает и выключает расширенные возможности

настройки прав на данные карточки. Если флаг установлен, права могут

быть назначены на все структурные элементы карточки: секции, строки

секций. Если флаг снят, действует упрощённый режим — права выдаются

только на карточку целиком.


Для повышения производительности крайне не

рекомендуется устанавливать признак Card is securable для

карточек без особой необходимости.

◦ Provides UI Extension — указывает, что карточка предоставляет расширение

Windows-клиента.

◦ High changes rate — включает и выключает режим, при котором штамп

времени карточки вычисляется по штампам времени секций карточки

(иначе штамп времени будет обновляться при изменении карточки).

Рекомендуется устанавливать данный признак для карточек с высокой

частотой изменения (например, он установлен у системной карточки

папок).

◦ Use server extension when checking access to the card — указывает, что для

проверки прав доступа к карточке используется ролевая модель

безопасности.

◦ Client-side data caching on disk is restricted — запрещает кэширование

данных карточки на клиенте.

11. Введите дескриптор безопасности, определяющий набор прав, назначаемых

по умолчанию при создании экземпляров карточки, в поле Default security

descriptor.

В дескрипторе можно использовать только константные идентификаторы

объектов (well-known security identifiers), т.к. экземпляры карточки будут

создаваться в другом домене чем тот, где она разрабатывается.

Добавление секции

1. Откройте настройки карточки (Edit › Card Properties).

2. Вызовите команду New Section из контекстного меню узла Sections в дереве

объектов.

3. Выберите добавленную секцию в дереве объектов.
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Рисунок 15. CardManager — Добавление секции

4. Введите псевдоним секции в поле Псевдоним.

Псевдоним секции должен отвечать следующим требованиям: отличаться от

псевдонима карточки, быть уникальным в рамках карточки, содержать только

латинские символы, не содержать пробелы.

5. Введите локализованные названия секции в таблице Названия.

6. Если необходимо, измените уникальный идентификатор секции в поле

Идентификатор.

7. Выберите тип секции в списке Тип:

◦ struct — секция позволяет хранить данные одного набора полей (строки

секции).

◦ table — секция позволяет хранить данные одного или нескольких

несвязанных наборов полей (строк секции).
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◦ tree — секция позволяет хранить данные одного или нескольких

связанных или несвязанных наборов полей (строк секции). Строки

связываются по принципу родитель-потомок. Все строки имеют

идентичный набор полей — аналогично типу table.

Следующие шаги могут быть выполнены только после добавления полей в

секцию.

8. Если секция является секцией свойств, установите флаг Содержит свойства
карточки и настройте атрибуты.



Секция свойств — это специальный вид секций, содержащих ряд

предопределённых полей, которые могут выступать в качестве

пользовательских атрибутов карточки (свойств). Платформа

позволяет обрабатывать свойства карточки специальным

образом — например, выводить их в представления или

синхронизировать их значения со свойствами файлов Office.

При отметке какой-либо секции как содержащей свойства, необходимо

указать ключевые поля этой секции:

◦ Имя — поле, содержащее название свойства (строка).

◦ Значение — поле, содержащее значение свойства (чаще всего — variant).

◦ Отображаемое — поле, содержащее отображаемое значение свойства

(строка).

◦ Тип — поле, определяющее тип свойства (перечисляемое).

9. Выберите поля, из которых составляются описания (дайджесты) строк

секции, в списке Поля для отображения строки.

Значения указанных полей приводятся к строчному выражению,

объединяются в порядке их описания и отделяются друг от друга пробелом.

Например, секция содержит данные о сотрудниках организации и имеет

несколько полей, среди которых есть Name (имя), SurName (фамилия) и

MiddleName (отчество).

Если выбрать эти три поля в качестве полей для отображения строки, то во

всех элементах управления выбранная строка данной секции будет

отображаться как Фамилия Имя Отчество.
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10. Выберите поля секции, по которым выполняется сортировка строк при

обращении к данным секции, в списке Поля для сортировки.

Для конкретного поля может быть выбрана прямая или обратная сортировка.

Сортировка производится в порядке следования этих полей в описании.

11. Добавьте поля, для которых должна быть обеспечена уникальность или

индексация, в таблицу Индексы и ограничения.

Возможные типы ограничений, обеспечивающих уникальность, и способов индексации:

◦ Unique globally — значение поля (или набора полей) уникально в рамках

сервера Docsvision.

◦ Unique within card — значение поля (или набора полей) уникально в рамках

экземпляра карточки.

◦ Unique within section — значение поля (или набора полей) уникально в

рамках секции.

◦ Unique within tree — значение поля (или набора полей) уникально в рамках

всех уровней иерархической секции.

◦ Clustered index — по полю строится кластерный индекс.

◦ Nonclustered index — по полю строится некластерный индекс.

◦ Unique clustered index — по полю строится уникальный кластерный индекс.

◦ Unique nonclustered index — по полю строится уникальный некластерный

индекс.

12. Настройте дополнительные параметры секции:

◦ Допускает одновременный доступ — разрешает одновременную работу

нескольких пользователей с данными секции (чаще всего этот признак

устанавливается для справочников и требует отказа от блокировки

карточки).

◦ Исключить из поиска — скрывает поля секции из диалога поиска.

◦ Из раздела могут быть выбраны строки — включает/выключает возможность

выбора строк из секции (чаще всего этот признак устанавливается для

секций справочников).

◦ Запись событий в журнал необязательна — блокирует запись сообщений об

изменении строк секции в системный журнал.

 Для повышения производительности рекомендуется

29



устанавливать данный признак для секций, с которыми

производится интенсивная работа (например, для секций с

данными журналирования).

◦ Не копировать данные раздела — включает и выключает режим, при котором

при копировании карточки в копию не будут копироваться строки данной

секции.

◦ Секция защищенная — указывает, что у строк секции есть собственные

дескрипторы безопасности.

◦ Элементы неудаляемые — запрещает удалять строки из секции.

◦ Не редактировать строки с иного сервера — запрещает изменять строки секции,

созданные на другом сервере. Используется Модулем репликации

справочников.

◦ Не изменять дочерние строки с иного сервера — запрещает изменять строки

подсекций, созданных на другом сервере. Используется Модулем

репликации справочников.

◦ Секция использует общее хранилище — включает и выключает оптимизацию, при

которой для нескольких плоских секций одного уровня в БД будет создана

общая таблица.


Для использования данной оптимизации, признак Секция
использует общее хранилище следует устанавливать у нескольких

секций одного уровня.

Добавление поля

1. Выберите секцию, в которую добавляется поле, в дереве объектов.

2. Вызовите команду New Field из контекстного меню секции.

3. Выберите добавленное поля в дереве объектов.
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Рисунок 16. CardManager — Добавление поля

4. Введите псевдоним поля в поле Псевдоним.

Псевдоним поля должен:

◦ Быть уникальным в рамках карточки.

◦ Содержать только латинские символы.

◦ Не содержать пробелы.

5. Выберите тип поля в списке Тип:

◦ int — целое.

◦ bool — булево значение (Да/Нет).

◦ datetime — дата и время.

◦ date — дата.

◦ time — время.
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◦ enum — перечисление (предопределённый набор уникальных значений).

◦ bitmask — битовая маска.

◦ uniqueid — уникальный идентификатор.

◦ userid — идентификатор пользователя.

◦ string — строка (не более 8000 символов).

◦ unistring — строка в формате Unicode (не более 4000 символов).

◦ fileid — идентификатор файла Docsvision.

◦ float — число с плавающей точкой.

◦ refid — ссылка на строку другой секции.

◦ refcardid — ссылка на карточку.

◦ text — текст (не более 231-1 байт).

◦ unitext — текст в формате Unicode (не более 231-1 байт).

◦ binary — двоичные данные.

◦ image — изображение.

◦ sdid — идентификатор безопасности.

◦ decimal — десятичное число.

◦ variant — значение переменного типа.

6. Если для поля был выбран строчной тип, укажите ограничение длины для

текстовых данных в поле Размер.

7. Если для поля был выбран ссылочный тип, выберите тип ссылки в списке Тип

ссылки:

◦ Weak — связанный объект разрешено удалять. При удалении объекта,

содержащего ссылку, связанный объект останется.

◦ Hard — связанный объект запрещено удалять, пока на него существует

ссылка. При удалении объекта, содержащего ссылку, связанный объект

также будет автоматически удален.

◦ None — при удалении связанного объекта значение ссылочного поля будет

очищено.

◦ Auto — при удалении связанного объекта будет удалена вся строка

секции, содержащей ссылку.
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8. Выберите режим копирования значения поля в списке Копирование:

◦ Null — значение поля при копировании обновляется.

◦ Copy — значение поля копируется.

◦ CreateNew — создание нового значения (используются для ссылок).

9. Введите локализованные названия поля в таблице Названия.

10. Введите локализованные описания поля, для отображения в подсказках к

полю в диалогах поиска и представлений, в таблице Description.

11. Если необходимо, измените уникальный идентификатор секции в поле

Идентификатор.

12. Если поле является ссылочным, выберите тип карточки (схема карточки

должна быть загружена в программу), на которую ссылка, в поле Тип, куда

ссылаемся (ID), а также секцию карточки в поле Раздел, куда ссылаемся (ID).

13. Если требуется, укажите значение по умолчанию в поле Значение по

умолчанию (флаг должен быть установлен).

14. Настройте дополнительные параметры нового поля:

◦ Обязательное — включает и выключает режим, при котором для сохранения

карточки значение поля не должно быть пустым. Система не позволит

сохранить карточку, если значение поля не задано.

◦ Зависит от пользователя — указывает, что значение поля сопоставляется с

конкретным пользователем системы. Таким образом, для каждого

пользователя может храниться собственное уникальное значение данного

поля.

◦ Исключить из поиска — указывает, что поле не участвует в поиске, т.е. не

отображается в диалоге поиска.

◦ Удалять связанную строку при изменении значения — включает и выключает

удаление связанных строк при изменении значения данного поля,

используется для ссылочных полей.

◦ Отображается на форме карточки — включает и выключает режим, при котором

поле может быть сопоставлено с элементом пользовательского

интерфейса. Этот признак используется в Справочнике типов.

◦ Системное (обновляется автоматически) — указывает, что поле является

системным. Учитывается при некоторых операциях с данными.

15. Настройте список полей связанной карточки в последней таблице.
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Если поле является ссылочным, можно настроить список полей для секции,

на которую указывает ссылка. Значения полей из списка будут загружаться

вместе со значением данного поля. Это позволяет снизить число обращений к

серверу при чтении данных карточки или при её экспорте и печати.

Добавление команды карточки

Команды карточки — это список действий, которые могут быть вызваны из

контекстного меню карточки в Windows-клиенте. В качестве команд могут

выступать, например, команды: Открыть в другом режиме, Переслать,

Списать в архив и т. д.

Разработчик сам определяет перечень этих команд, их названия и семантику.

Фактически, все описанные команды появляются в меню действий над

карточкой в окне Windows-клиента. При выборе пользователем одной из команд

будет вызван клиентский компонент карточки с указанием идентификатора

активированной команды и требуемые операции нужно будет

запрограммировать самостоятельно в коде этого компонента.

Чтобы добавить команду карточки:

1. Откройте настройки карточки (Edit › Card Properties).

2. Вызовите команду New Action из контекстного меню узла Actions.

3. Выберите добавленную команду карточки в дереве объектов.
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Рисунок 17. CardManager — Добавление команды

4. Введите псевдоним команды в поле Псевдоним.

Псевдоним команды должен отвечать следующим требованиям:

◦ Быть уникальным в рамках карточки,

◦ Содержать только латинские символы,

◦ Не содержать пробелы.

5. Введите локализованные названия команды в таблице Названия.

Данные названия используются для отображения команды в списке Действия

контекстного меню карточки.

Добавление режима работы карточки

Режим работы карточки передается в компонент карточки при её открытии и

определяет её пользовательский интерфейс, а также бизнес-логику.
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Соответствующая функциональность должна быть реализована программистом в

компоненте карточки.

Чтобы добавить режим работы карточки:

1. Откройте настройки карточки (Edit › Card Properties).

2. Вызовите команду New Mode из контекстного меню узла Modes.

3. Выберите добавленный режим работы карточки в дереве объектов.

Рисунок 18. CardManager — Добавление режима работы карточки

4. Введите псевдоним режима в поле Псевдоним.

Псевдоним режима должен отвечать следующим требованиям:

◦ Быть уникальным в рамках карточки.

◦ Содержать только латинские символы.

◦ Не содержать пробелы.
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5. Введите локализованные названия режима в таблице Названия.

Добавление преобразования данных карточки

Преобразование данных позволяет подготовить данные карточки для печати или

экспорта.

Системой поддерживаются два типа преобразований: XSLT-преобразования (они

используются для получения HTML-представления данных карточки при выводе

на печать) и преобразования Microsoft InfoPath.

Чтобы добавить преобразование карточки:

1. Откройте настройки карточки (Edit › Card Properties).

2. Вызовите команду New Transformation из контекстного меню узла

Transformations дерева объектов.

3. Выберите добавленное преобразование карточки в дереве объектов.
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Рисунок 19. CardManager — Добавление преобразования данных

4. Введите псевдоним преобразования в поле Псевдоним.

Псевдоним преобразования должен отвечать следующим требованиям:

◦ Быть уникальным в рамках карточки.

◦ Содержать только латинские символы.

◦ Не содержать пробелы.

5. Введите локализованные названия преобразования в таблице Названия.

6. Выберите язык локализации преобразования в списке ru, en, uk.

Каждое преобразование относится только к конкретному языку, нельзя

использовать одно преобразование сразу для всех языков.

7. Выберите тип преобразования в списке Тип преобразования:

◦ Xslt — XSLT.
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◦ InfoPath — Microsoft InfoPath.

◦ Custom — пользовательский тип.

8. Если был выбран пользовательский тип преобразования, укажите тип

содержимого в файле преобразования:

◦ Text — текст.

◦ Xml — XML.

◦ Binary — двоичные данные.

9. Укажите путь к файлу с данными преобразования в поле Файл

преобразования.

10. Если преобразование должно быть выбрано при экспорте, установите флаг

Использовать по умолчанию.

Добавление виртуального поля

Виртуальное поле представляет собой правило для формирования данных,

которые физически не хранятся в самой карточке, но могут быть использованы

при построении представлений (отчётов) с участием карточек такого типа.

В качестве источника данных для виртуального поля могут выступать:

• Физическое поле самой карточки.

• Физическое поле карточки другого типа, которая связана с данной.

• Системные данные о карточке (например, дата последнего изменения).

• Результат вычислений, произведённых над любым из вышеперечисленных

полей.

Виртуальные поля, определённые в схеме карточки, всегда доступны в рамках

соответствующих секций в диалоге настройки представления. Дополнительные

виртуальные поля могут быть добавлены из РМА.

Чтобы добавить виртуальное поле карточки:

1. Откройте настройки карточки (Edit › Card Properties).

2. Вызовите команду New Virtual Field из контекстного меню узла Virtual Fields

дерева объектов.

3. Выберите добавленное виртуальное поле в дереве объектов.
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Рисунок 20. CardManager — Добавление виртуального поля

4. Введите псевдоним виртуального поля в поле Псевдоним.

Псевдоним виртуального поля должен отвечать следующим требованиям:

◦ Быть уникальным в рамках карточки.

◦ Содержать только латинские символы.

◦ Не содержать пробелы.

5. Введите локализованные названия виртуального поля в таблице Названия.

6. Введите локализованные описания виртуального поля, для отображения в

подсказках к полю в диалогах поиска и представлений, в таблице Description.

7. Выберите тип виртуального поля в списке Тип:

◦ int — целое.
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◦ bool — булево значение.

◦ datetime — дата и время.

◦ uniqueid — уникальный идентификатор.

◦ string — строка.

◦ unistring — строка в формате Unicode.

◦ float — число с плавающей точкой.

◦ unitext — текст в формате Unicode.

◦ decimal — десятичное число.

◦ binary — двоичные данные.

8. Выберите секцию, на основе данных которой строится виртуальное поле.

Из этой секции будут выбираться физические поля для вычислений, и к ней

будут последовательно присоединяться другие секции или таблицы.

9. В элементе Определение поля выберите метод получения данных

вычисляемого поля:

◦ Поле секции — физическое поле основной или присоединённой секции.

◦ Вычисляемое поле — вычисляемое поле по данным физического поля

основной или присоединённой секции.

10. В таблице Присоединенные разделы определите связи основной секции

виртуального поля с другими секциями или таблицами.

a. Кликните Добавить. Будет открыто диалоговое окно добавления

присоединяемого раздела.
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Рисунок 21. CardManager — Присоединение раздела

b. Введите псевдоним присоединенного раздела в поле Alias.

c. Выберите оригинальную секцию и поле, по которому связываются секции,

в полях Source section и Source field.

d. Выберите присоединяемую секцию и поле, с которыми связываются

секции, в полях Target section и Target field.

e. Если необходимо, настройте условия фильтрации записей присоединённой

секции в поле Conditions.

11. Нажмите кнопку Изменить, расположенную справа от элемента Определение

поля. Будет открыто окно настройки виртуального поля:

◦ Если в элементе Определение поля выбран режим Поле секции, укажите

поле основной или присоединенной секции, из которого будут получены

данные виртуального поля.
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Рисунок 22. CardManager — Выбор поля секции

◦ Если в элементе Определение поля выбран режим Вычисляемое поле,

настройте вычисляемое поле.
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Рисунок 23. CardManager — Добавление вычисляемого поля

Описание вычисляемого поля по сути представляет собой совокупность

атомарных операций (элементов), выполняющихся в определённом

порядке, который задаётся через иерархические группы. Внутри каждой

группы элементы могут объединяться арифметической операцией (+, -, \*,
/), логической операцией (AND, OR) или агрегацией.

Вычисления одного уровня исполняются строго последовательно, поэтому

важно контролировать порядок их выполнения. Для этого можно

перемещать элементы внутри группы кнопками Up и Down.

Чтобы настроить вычисляемое поле:

a. Выберите тип данных, возвращаемых при вычислении, в поле Result

type.

b. Если требуется создать группу операций, нажмите кнопку Add group.
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c. Чтобы добавить атомарную операцию, нажмите кнопку Add item.

При добавлении атомарной операции в существующую по умолчанию

группу, необходимо выбрать тип элементов данной операции:

◦ Simple — значение физического поля секции, предопределённое значение

или результат применения к нему простейшей функции.

◦ Switch — результат селекции, сопоставляющей конкретным данным

физического поля предопределённые значения.

◦ Conditions — условный оператор, формирующий значение элемента в

зависимости от значений других элементов.

Рисунок 24. CardManager — Добавление операции для вычисляемого поля
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Важно контролировать типы конкретных элементов вычислений и их групп,

чтобы избежать ошибок в вычислениях, и получить правильный тип

результирующего значения.

Подключение базы данных Docsvision

CardManager предоставляет возможность загружать разработанные библиотеки

карточек напрямую в БД. Для этого необходимо подключить БД Docsvision, в

которую будут выгружаться схемы карточек.

1. В дереве объектов выберете узел Databases.

2. Вызовите команду Register Database из контекстного меню выбранного узла.

Рисунок 25. CardManager — Регистрация базы данных в утилите

3. Выберите из списка тип СУБД с БД Docsvision: PostgreSQL или Microsoft SQL

Server.

4. Введите данные для подключения к БД: адрес сервера, данные пользователя,

имя базы данных.
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
При подключении к серверу PostgreSQL укажите имя сервера в

формате Адрес:Порт, например, postgre.server.com:5432. В

противном случае база не будет добавлена.

Пользователь, от имени которого выполняется подключение, должен

обладать полными правами на подключаемую БД.

5. Нажмите кнопку ОК.

В список подключенных БД будет добавлена новая запись. Если данные для

подключения указаны неверно, будет показана ошибка.

Создание базы данных

CardManager может использоваться для создания БД Docsvision и загрузки в неё

необходимых библиотек карточек.



При создании БД с помощью CardManager, в ней будут созданы

таблицы для хранения данных карточек, а также некоторые

хранимые процедуры, загружаемые с библиотеками карточек.

Полученная БД не является полноценной базой системы Docsvision

из-за отсутствия данных, загружаемых Консолью администратора

Docsvision, например, заданий SQL, данных приложения

"Управление документами" и других данных.

Чтобы создать базу данных:

1. Загрузите в программу библиотеки карточек базовых модулей Docsvision:

◦ C:\Program Files
(x86)\Docsvision\Platform\Tools\Database\ApprovalDesigner\ApprovalDesignerCardL
ib.xml.

◦ C:\Program Files
(x86)\Docsvision\Platform\Tools\Database\BackOffice\BackOfficeCardLib.xml.

◦ C:\Program Files
(x86)\Docsvision\Platform\Tools\Database\Core\SystemCardLib.xml.

◦ C:\Program Files
(x86)\Docsvision\Platform\Tools\Database\DocumentManagement\DocumentManagementC
ardLib.xml.
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◦ C:\Program Files
(x86)\Docsvision\Platform\Tools\Database\TakeOffice\TakeOfficeCardLib.xml.

◦ C:\Program Files
(x86)\Docsvision\Platform\Tools\Database\WindowsClient\WindowsClientCardLib.xml.

◦ C:\Program Files
(x86)\Docsvision\Platform\Tools\Database\Workflow\WorkflowCardLib.xml.

◦ C:\Program Files
(x86)\Docsvision\Platform\Tools\Database\WorkerService\WorkerServiceCardLib.xml.

Здесь C:\Program Files (x86)\Docsvision\Platform\ — каталог установки

сервера Docsvision.

Также можно добавить другие библиотеки карточек, которые нужно

загрузить при создании БД, или их можно загрузить после создания БД.

2. В дереве объектов выберете узел Databases.

3. Вызовите команду New Database из контекстного меню выбранного узла.

Будет открыта форма:
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Рисунок 26. CardManager — Регистрация базы данных в утилите

4. Выберите тип СУБД: PostgreSQL или Microsoft SQL Server.

5. Укажите данные для подключения к СУБД (адрес сервера, данные

пользователя, имя базы данных).

У пользователя должны быть права, достаточные для создания БД.

6. Введите имя базы данных.

7. Нажмите кнопку ОК.

На указанном сервере будет создана новая БД, она же будет добавлена в

список подключенных БД. Если данные для подключения указаны не верно,

будет показана ошибка.
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Загрузка библиотеки карточек в базу данных
Docsvision

Прежде чем загружать в БД собственную библиотеку карточек, нужно загрузить

в программу CardManager следующие библиотеки карточек базовых модулей

Docsvision:

• Platform — файл SystemCardLib.xml.

• BackOffice — файл BackOfficeCardLib.xml.

• ApprovalDesigner — файл ApprovalDesignerCardLib.xml.

• TakeOffice — файл TakeOfficeCardLib.xml.

• Workflow — файл WorkflowCardLib.xml.

• WorkerService — файл WorkerServiceCardLib.xml.


Файлы со схемами метаданных перечисленных выше библиотек

карточек размещаются на сервере Docsvision в папке \Каталог-
установки-сервера-Docsvision\Tools\Database.

При загрузке стандартных библиотек карточек следует соблюдать зависимости

модулей друг от друга.

В общем случае порядок загрузки стандартных библиотек карточек следующий:

1. Platform — файл SystemCardLib.xml.

2. WindowsClient — файл WindowsClientCardLib.xml.

3. WorkerService — файл WorkerServiceCardLib.xml.

4. BackOffice — файл BackOfficeCardLib.xml.

5. DocumentManagement — файл DocumentManagementCardLib.xml.

6. ApprovalDesigner — файл ApprovalDesignerCardLib.xml.

7. TakeOffice — файл TakeOfficeCardLib.xml.

8. Workflow — файл WorkflowCardLib.xml.

Чтобы загрузить библиотеки карточек в БД Docsvision:

1. Подключите БД Docsvision, в которую загружается библиотека карточек.

2. Выберите подключенную БД в дереве объектов.
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3. Вызовите команду Load library to database из контекстного меню выбранной

базы данных.

Рисунок 27. CardManager — Выбор выгружаемой библиотеки карточек

4. Выберите в списке библиотеку карточек, которую нужно загрузить в БД и

нажмите ОК.

Операция выгрузки может занять продолжительное время.

После завершения операции, выгруженная библиотека карточек появится в

узле базы данных.

5. Перезагрузите сервер Docsvision и клиентские приложения, чтобы получить

доступ к карточкам библиотеки.

Импорт схемы метаданных библиотеки карточек
из файла

Чтобы загрузить схему метаданных библиотеки карточек из файла:

1. Вызовите команду File › Open › Open Library. Будет открыто окно выбора

файла.
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2. Выберите файл, содержащий метаданные библиотеки карточек. В узел Card

libraries дерева объектов будет добавлена выбранная библиотека карточек.

Импорт схемы метаданных карточки из файла

Чтобы загрузить схему метаданных карточки из файла:

1. В дереве объектов выберите библиотеку карточек, в которую будет

загружена карточка.

2. Вызовите команду File › Open › Open Card. Будет открыто окно выбора

файла.

3. Выберите файл, содержащий метаданные загружаемой карточки. В

библиотеку карточек будет добавлена выбранная карточка.
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DVExplorer

Программа "DVExplorer" предоставляет прямой доступ к данным Docsvision

(карточкам, файлам, журналам и др.), минуя объектную модель карточек и т.п.

Программа должна быть запущена под учетной записью локального

администратора.

Рисунок 28. Главное окно программы DVExplorer

Главное окно программы содержит следующие элементы:

• Секция Connection settings с настройками подключения к серверу Docsvision.

• Секция Authentication settings с данными аутентификации для подключения к

серверу Docsvision.

• Панель команд с командами:

◦ Connect — выполняет подключение к серверу Docsvision с использованием

заданных настроек.

◦ Session — открывает список пользовательских сессий.

◦ Card types — открывает окно с описанием метаданных карточек.

◦ Settings — открывает окно с настройками текущей пользовательской

сессии.

◦ Cards — открывает окно, содержащее инструменты для поиска карточек и

работы с ними.
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◦ Locks — открывает список блокировок, установленных на карточки и

файлы.

◦ Reports — открывает список загруженных в БД отчетов.

◦ Log — открывает окно, содержащее инструменты для работы с журналами

Docsvision.

◦ Icons — открывает окно, содержащее инструменты для работы с иконками

в БД Docsvision.

◦ Files — открывает окно, содержащее инструменты для поиска файлов и

работы с ними.

◦ Label — открывает окно, содержащее инструменты для работы с метками.

◦ Close.

Подключение к серверу Docsvision

1. В главном окне программы введите адрес сервера Docsvision в поле Address.

Адрес должен быть в формате:

http://docsvision.server.com:5000/StorageServer/StorageServerService.asmx.

2. Введите название подключаемой БД в поле Database.

Чтобы подключиться к БД по умолчанию, оставьте поле пустым.

3. Если требуется, измените код локали в поле Language.

4. Выберите тип аутентификации, используемой при подключении к серверу

Docsvision, в секции Authentication settings: NTLM-аутентификация, базовая

аутентификация (с вводом пароля), аутентификация по сертификату.


NTLM-аутентификация и аутентификация по сертификату не

поддерживаются в Docsvision версии 6.1.

Пользователь, от имени которого выполняется подключение, должен быть

членом группы DocsVision Users. Для получения полных прав доступа,

пользователь должен являться администратором Docsvision.

5. Нажмите на кнопку Connect.

Будет показано диалоговое окно с идентификатором открытой сессии.
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Список подключений

Нажмите кнопку Sessions на панели команд, чтобы открыть окно со списком

пользовательских сессий.

Рисунок 29. Список сессий

Данное окно содержит следующие элементы:

• Список пользовательских сессий, в котором содержится следующая

информация:

◦ Имя пользователя, который выполнил подключение.

◦ Название компьютера пользователя.

◦ Время подключения.

◦ Время бездействия, в течение которого пользователь не осуществлял

операций на сервере (получение или изменение данных).

• Набор фильтров:

◦ Скрыть офлайн сессии — скрывает сессии, которые были переведены в офлайн

режим.

◦ Показать только сессии, активные в течение последних … минут — отображает

только сессии, которые были активны в течении последних нескольких

минут.

◦ Группировать по пользователям — включает группировку сессий по

пользователям.

• Кнопки:
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◦ Close.

◦ Refresh.

◦ Close session — закрывает выбранную сессию.

Список типов карточек

Нажмите кнопку Card types на панели команд, чтобы открыть окно с описанием

типов карточек, загруженных в БД Docsvision.

Рисунок 30. Список типов карточек, зарегистрированных в БД Docsvision

Данное окно содержит следующие элементы:

• Список типов карточек, зарегистрированных в БД.

• Selected type ID — идентификатор типа карточек, который выбран в списке.

• Additional flags — дополнительные флаги типа карточек.

• кнопки:

◦ Sections — открывает список секций и полей выбранной карточки.
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Рисунок 31. Описание структуры секции карточки

◦ Actions — открывает список команд, понятных карточке.

Рисунок 32. Действия карточки

◦ Modes — открывает список режимов работы карточки.
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Рисунок 33. Режимы работы карточки

◦ XML — открывает на просмотр схему метаданных карточки.

Рисунок 34. XML-описание карточки

◦ XSD — открывает XSD-схему карточки.
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Рисунок 35. XSD-описание карточки

◦ Transform — открывает список преобразований карточки.

Рисунок 36. Список преобразований карточки

Для просмотра кода преобразования нажмите на кнопку View.
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Рисунок 37. Просмотр XSLT-шаблона печати

◦ Security — открывает окно настройки безопасности для типа карточек.

Параметры текущей пользовательской сессии

Нажмите кнопку Settings на панели команд, чтобы открыть окно с параметрами

текущей пользовательской сессии.

Рисунок 38. Параметры пользовательской сессии

Данное окно содержит следующие элементы:

• Список параметров текущей пользовательской сессии.


Перечень параметров пользовательской сессии с описанием

приведен в /dv6/programmer/dv6/[Руководстве по разработке].
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• Кнопки:

◦ Close.

◦ Change — открывает диалоговое окно изменения значения выбранного

параметра.

Работа с карточками

Нажмите кнопку Cards на панели команд, чтобы открыть окно с инструментами

поиска карточек и работы с ними.

Рисунок 39. Список карточек типа Задание

Данное окно содержит следующие элементы:

• Страница Cards by type:

◦ Select card type — выбирает тип отображаемых карточек.

• Страница Advanced search:

◦ Search string — строка настройки поискового запроса.
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• Страница Find by Id

◦ ID — строка поиска карточек по идентификатору.

• Список карточек, соответствующих критериям поиска/фильтрации по типу.

• Selected card ID — идентификатор выбранной карточки.

• Template — устанавливает флаг "Шаблонная" у выбранной карточки.

• Delete card — устанавливает флаг "Удаленная" у выбранной карточки.

• Archive card — устанавливает флаг "Архивная" у выбранной карточки.

• Панель команд с кнопками:

◦ Search — применяет условие выбора карточек по типу, выполняет

поисковый запрос.

◦ Close.

◦ Create — Создаёт новый экземпляр карточки указанного типа.

◦ Delete — удаляет выбранную карточку.

◦ Copy — Создаёт копию выбранной карточки.

◦ Attributes — открывает окно с атрибутами выбранной карточки.

Рисунок 40. Атрибуты карточки

◦ Card data — открывает окно для работы с содержимым (полями и

секциями) карточки.

◦ Component — открывает карточку с использованием пользовательского
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интерфейса данной карточки.

◦ Links — открывает список ссылок на карточку и ссылок карточки.

Рисунок 41. Ссылочные карточки

◦ Security — отображает диалоговое окно настройки безопасности карточки.

◦ Import — импортирует данные карточки из файла XML.


Карточки, содержащие отсылки к версии компонентов, не

рекомендуется напрямую импортировать в версию 6.1 и

выше, если они выгружены из версии 5.5.

◦ XML — открывает окно просмотра и экспорта в файл данных карточки.
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Рисунок 42. Данные карточки в формате XML

◦ HTML — открывает окно экспорта и печати карточки с использованием

шаблона печати.

Рисунок 43. Данные карточки с примененным шаблоном печати
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Выбор карточек определенного типа

Чтобы получить список всех карточек определенного типа, выберите тип

карточек в раскрывающемся списке Select card type на странице Card by type.

В списке карточек будут показаны все карточки выбранного типа.

Расширенный поиск

Чтобы выполнить поиск карточек с использованием полнотекстового и/или

атрибутивного поиска, нажмите кнопку … в строке Search string на странице

Advanced search. Будет открыто окно настройки поискового запроса.

Рисунок 44. Диалоговое окно настройки поискового запроса

Данное окно содержит следующие элементы:

• Страница Полнотекстовый — содержит настройки полнотекстового поиска

(если доступен), а также общие параметры поиска.

• Страница Атрибутивный — содержит настройки атрибутивного поиска

карточек.
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Рисунок 45. Страница настройки атрибутивного поиска

• Страница Папки — содержит дерево папок Docsvision для выбора папок, по

которым должен производиться поиск.

• Страница Типы — содержит список типов карточек для выбора типов

карточек, по которым должен производиться поиск.

• Страница XML — содержит редактор XML-кода поискового запроса.


После изменения XML-кода поискового запроса, возможность

настройки поискового запроса с помощью визуальных

инструментов будет заблокирована.

• Панель команд с кнопками:

◦ OK.

◦ Cancel.

◦ Load — загружает сохраненный поисковый запрос.
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◦ Save — сохраняет поисковый запрос.

◦ Save as — сохраняет поисковый запрос с новым названием.

◦ Import — импортирует поисковый запрос из XML файла.

◦ Export — выгружает поисковый запрос в XML файл.

Поиск карточки по идентификатору

Чтобы найти карточку с определенным идентификатором:

1. Перейдите на страницу Find by Id.

2. Введите идентификатор искомой карточки в поле ID.

3. Нажмите кнопку Search.

Работа с данными карточки

Найдите карточку, данные которой нужно изменить, выберите её и нажмите

кнопку Card data на панели команд, чтобы открыть окно с данными выбранной

карточки.
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Рисунок 46. Данные карточки

Данное окно содержит следующие элементы:

• Список дочерних секций на текущем уровне.

• Строки выбранной секции.

• Поля выбранной строки секции.

• Панель команд с кнопками:

◦ BeginUpdate — включить режим отложенных изменений.

◦ UpdateNow — записать изменения.

◦ CancelUpdate — отменить несохраненные изменения и выключить режим

отложенных изменений.
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◦ EndUpdate — записать изменения и выключить режим отложенных

изменений.

◦ Refresh — обновить данные.

◦ Find by Id — выполнить поиск секции по идентификатору, указанному в

поле ввода.

◦ RefreshLinked — обновить только данные связанных полей.

◦ Security — отобразить диалог настройки прав доступа на объект.

◦ Add new — создать новую строку.

◦ Copy — копировать выбранную строку.

◦ Delete — удалить выбранную строку.

◦ Enter section — опуститься вниз по иерархии секций.

◦ Leave section — подняться вверх по иерархии секций.

◦ Find by Id — выполнить поиск строки секции по введенному

идентификатору.

Данный раздел DVExplorer предоставляет возможность создавать и удалять

строки секций, а также изменять значения полей, изменение которых

разрешено.

При работе с секцией иерархического типа для создания вложенной строки

перетащите существующую строку в другую с помощью мыши.

Список блокировок

Нажмите кнопку Card Locks на панели команд, чтобы открыть окно со списком

блокировок, установленных на карточки и файлы.

Администраторам Docsvision доступны блокировки всех пользователей, рядовым

пользователям — только собственные блокировки.
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Рисунок 47. Список блокировок

Данное окно содержит следующие элементы:

• Страница Карточки — содержит список блокировок карточек, в котором

отображаются: тип карточки, дайджест, владелец блокировки, вид

блокировки (временная или постоянная).

• Страница Файлы — содержит список блокировок файлов, в котором

отображаются: имя файла, владелец блокировки, вид блокировки.

• Панель команд с кнопками:

◦ Close.

◦ Refresh.

◦ Unlock — снимает выбранную блокировку.

Работа с файлами

Нажмите кнопку Files на панели команд, чтобы открыть окно с инструментами

для работы с файлами.
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Рисунок 48. Диалоговое окно с инструментами для работы с файлами

Данное окно содержит следующие элементы:

• Настройки фильтра поиска файлов:

◦ Finding — строка поиска по содержимому файлов.

◦ Mask — маска искомых файлов в формате ".".

◦ Size (Kb) — минимальный и максимальный размер файла.

◦ Date — промежуток времени создания файла.

• Список файлов, соответствующих условиям фильтра.

• Selected file ID — идентификатор выбранного файла.

• Archive file — устанавливает для файла признак "Архивный".

• Offline file — устанавливает для файла признак "Офлайн".

• Панель команд с кнопками:

◦ Find — осуществляет поиск файлов.
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◦ Create — загружает в БД новый файл.

◦ Delete — удаляет выбранный файл.


Будьте внимательны при удалении файлов, т.к. они могут

быть связаны с действующими карточками.

◦ Copy — Создаёт дубликат файла с новым идентификатором.

◦ Save — сохраняет выбранный файл в файловую систему.

◦ Load — заменяет выбранный файл файлом из файловой системы.

◦ Sign — подписывает файл сертификатом.

◦ Encrypt — зашифровывает файл с помощью сертификата.

◦ Security — открывает диалоговое окно настройки безопасности.

Окно с информацией о файле открывается при двойном щелчке по файлу.

Рисунок 49. Информация о файле
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